Installing the WinTV driver and WinTV
v7 application
Install your WinTV products. Turn on your Windows XP, Vista or Windows 7 based
PC, and boot into Windows.

For Windows XP installations:
After you install your WinTV device and
boot Windows, a 'Found New Hardware'
wizard will appear.
Please cancel it and allow Windows to
load fully before proceeding. With
some WinTV products, you might see this
message two or three times. Please click
‘Cancel’ each time you see the New
Hardware Wizard.

Insert the WinTV Installation CD-ROM in
your PC’s CD-ROM drive.

For Windows 7: You will see an AutoPlay
message. Click Run Setup.exe

For all versions of Windows: The
“Hauppauge WinTV Installation CD-ROM”
window will appear on the screen.

ote: if the CD does not
autorun, navigate to the
CD and run the 'Setup.exe'
file.

N

Step 1. Install the WinTV
driver
Click the button labeled Step 1:
Install Drivers.
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A blue screen will open and begin installing the drivers for your WinTV.
Once the drivers have installed, a message will appear saying ‘Drivers have
been updated successfully’. Click on the bar to exit. You do not need to reboot
your PC until after Step 2

ote: the latest driver updates are available at:
www.hauppauge.com in the Support section.

N

Step 2: Install the WinTV applications
Click the button labeled Step 2: Install WinTV The setup application will then open
and begin automatically installing the WinTV application components. Once complete, click OK then Exit.

ote: Save your WinTV Installation CD! You will need it if you download new WinTV applications in the future.

N

Running WinTV for the first time
To run the WinTV v7 application for watching TV, recording
videos and playing them back on your PC, double click on the
WinTV icon on your
Windows desk top.
When you run WinTV for
the first time, the WinTV
Device Setup Wizard
appears. Select the TV
source that you are using.
On some model WinTVs,
you have multiple tuners
and therefore you can
select multiple sources. For
the WinTV-HVR-2250, you
can chose either ATSC or
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Digital QAM and Analog TV. You cannot chose both Digital ATSC and Digital QAM.

ote: If you’d like to use the A/V inputs, please see instructions below
in External audio/video sources.

N

If your TV source is ATSC digital over-the-air TV
Select Digital ATSC and click Next. In the ATSC Setup menu, click Next. You
will see the Digital ATSC
Scan scanning for digital
over-the-air channels.
The digital TV scanning
process will scan from channels 2 to 51. As TV channels are found, they will
appear in the Channel box.
When complete, click Next /

Next and OK.
ote: if you do not
receive any ATSC
digital TV channels, an
antenna signal booster might be needed. After adding a signal booster,
see below for instructions on rescanning and the Troubleshooting section
for information on choosing an antenna.

N

If your TV source is Clear QAM Digital Cable TV
Clear QAM digital cable TV
channels are those TV channels broadcast on a digital
cable network which are unencrypted (‘free to view’). If you
are using cable TV with clear
QAM programs, chose Digital
QAM and Next.
QAM channels which are
detected but are encrypted
are automatically not selected.
The resulting channels in the
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list might be both standard and high definition channels.

If your TV source is Analog cable TV
Select your Country and your
TV Source from the drop
down list. To automatically
scan for channels, click Next
to continue.
Click the Scan button and
WinTV will automatically scan
for analog channels. The scanning process takes about 10
minutes.

External audio/video
sources
You can bring video into the
WinTV from an external
audio/video source such as a
cable TV or satellite set top box.
In the Device Setup Wizard,
select External Inputs and
click Next.
You will be presented with the
option to add a Composite and
an S-Video Input. Please select
your country (if not correct) and
click Next.
If you wish to connect a source not normally designed for operation in your country, you can configure the Video Format manually from the drop down list. Change
the value from “AUTO”.
Note: Pal BGHIDK is the commonly used format in Europe. NTSC is the broadcast format used in North America.

Rescanning TV channels or adding an external A/V source
If you want to rescan for TV channels or add an A/V source (on those products
with an external A/V input), click the Configuration menu (Gear button in the
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lower left corner of WinTV v7).
Then click on the Devices tab. Choose your WinTV device by clicking on it, then
click Tuner setup. Chose the TV format you want to scan, then click Next. Click
Next and a new scan will be started. When the scan is complete, click Next / Next
and OK.

Using the WinTV v7 application
To watch TV, click the Watch TV button.
To see the TV Channel list, click your right mouse button in the TV window to
display the Options menu. Select Find Channel. You will see the channel list.
To display the channel list all the time, while the channel list is displayed, click the

Channel list display always on button.
Options menu
The Options menu is the main menu where you can select channels, turn on
close captions, open the TV Scheduler, show the TV Guide and many other of the
Close WinTV
WinTV source selector

Current channel
name and number

Channel list display always on
Fast channel select
numbers
TV Channel list

Configuration
menu
(Settings menu)
Program Info

Record/Pause/Play
controls

Playback file menu
Channel
up/down

Close captions
Watch TV
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Volume adjust
and mute

Options menu
click your right mouse button to view

Playback menu
Channel list

TV Scheduler
Close captions

Always on top

most important TV control functions.
To bring up the Options Menu, click your right mouse button once in the TV
window .
To see the channel list, click on Find channel. You will see the list of channels
which have been scanned.
To show the Channel menu as part of the TV window, click the Channel list

always on icon at the top of the channel list.
To turn on Close captions, click on Show Captions.
To manually schedule a TV recording, or to see which programs have been
scheduled, click on Scheduler.
To turn on the Always on Top mode, click on Stay on Top.

Watch, Pause and Record TV
WinTV v7 is always recording video to your PC’s hard drive while TV is being displayed. In this way, you can immediately skip back and replay the TV program
you are watching.
Clicking on the Pause button will cause the video to pause, while clicking the
Record button will cause the current TV program to be recorded to hard disk.
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Program Playback Stop
info
file
Settings
Record

Skip
back 1
minute

Skip
back 10
seconds

Skip
ahead 30
Skip
seconds ahead 1
minute
Pause/Play

Time bar

Recording your TV shows
If you want to record a TV show you are watching:
-

Click the Record button. The recorded file name will popup on the video for a
few seconds as the recording starts.

Stop button.

-

When you are finished recording, click the

-

Click the Playback
you just recorded

-

To play a video you recorded earlier, click the Playback File button and then
move your mouse and click once on the video you want to play. Click Open and
the file will start playing.

file button and select the last file recorded to play the video

The recorded video file is saved in the directory set in Recordings directory directory which can be found in the Configuration menu. The default directory is
MyVideos. To change this directory, click the Settings button and then the Folders
tab. Every time you record a file, a new file is automatically created. The file will be
formatted as (ChannelNumber)_(ChannelName)YearMonthDay_TIme.
For digital TV programs, the quality level recorded is the same as it is transmitted by
the TV station. For example, if the TV station is transmitting a high-definition program,
WinTV will record the program in high-definition.
Close captions, parental control information and SAP audio are recorded with digital
TV programs.
For analog cable TV using the built-in hardware MPEG-2 encoder, the quality of the
video recording is set to 6Mbits/sec. This will be a configurable setting in a future
version of WinTV v7.

If you want to pause a TV show you are watching:

page 7

-

Click the Pause button. Your TV video will stop and the Time counter will start
counting.

Play button

-

To start the video from where you paused, click the

-

To rewind the video to the beginning, click the
your video was paused, click the Play button.

-

To rewind the video 1 minute, click the Skip back 1 minute
button. If your video was paused, click the Play button.

Skip to the beginning button. If

The Delay counter displays how much time you are behind the live video. For
example, if the delay counter says 00:01:23, then the video window is showing
video 1 minute and 23 seconds behind live video.

Configuration menu
The WinTV v7 Configuration menu is accessed by clicking the gear button in
the lower left hand corner of WinTV v7.
General tab: you can set the Video Renderer which allows WinTV v7 to display
video with a wide range of graphics systems.
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Devices tab: allows is where you can re-scan for TV channels and set up the TV
sources in WinTV v7.

Parental control tab: is where you can set the Parental Control level.
Advanced options: you can set options
such as Convert TV recordings to
.MPG file type and Game mode here.

Selecting FM radio programs
On those WinTV products which support FM
radio, if you have scanned for FM radio staions
in the section entitled “Using WinTV for the first
time” you can change the WinTV v7 application
to FM by clicking FM radio in the Source
selector, found in the upper right hand corner
of the WinTV application.

IR blaster in WinTV v7
If you would like to use the Hauppauge IR blaster (on those WinTV models with IR
blaster built-in) to change the channels on your cable TV or satellite set top box,
see the section entitled “Configuring the remote control for WinTV v7”.

WinTV v7 TV Scheduler
WinTV v7’s built-in TV Scheduler allows you to schedule the recording of TV
shows. Once a record event is set, WinTV v7 can be closed and will “wake up” at
the desired time and tuned to the desired channel.
When a scheduled record event takes place, the WinTV v7 application records “in
background” so that you can continue to watch your live TV program, even as the
recording progresses.
The TV Scheduler can be found in the WinTV v7 Options menu. Right click
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your mouse button in the TV
window to see the Options
menu. Click Scheduler. To set up
an event for timed watching or
recording, click the Add button.
The items that need to be set for
each event are:
-

Name: you can add a name
to the recording. If you do not
enter a name, the name will be
in the channel/date format.

-

Channel: chose one of your

-

Start time: set to the desired

scanned channels.
start time. Click on the hour to set the hour, the minute to set the minute. Note: It
takes about 15 seconds to launch the WinTV and start recording.

-

Duration: number of minutes in the recorded program.

-

Recurrance: one time, daily, weekly. Note: If you set for Record Weekly,
you must also specify the Day of the Week for the recording.

-

Date to Begin Program: today's date is the default. Change this if you want to
schedule on another date.

-

Source selection: leave set
at WinTV to bring up the
WinTV at the requested time
and on the requested channel.

Once these are set, click OK. You
can add more recordings, clicking
OK after each event is set.
When you are finished click

Close. The WinTV program does
not have to be running for the
Schedular to work. If WinTV is
not running, it takes about 15 seconds to start WinTV and to start
the recording of TV.
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WinTV v7 keyboard shortcuts
Ctrl A

Aspect ratio

Ctrl P

Play

Ctrl D

Display the video and
audio format of the TV
program

Alt R

Record

Alt S

Stop

Ctrl F

Freeze the video

Alt T

Start TV

Ctrl Z

Open TV Scheduler

Ctrl C

Catch up

Ctrl O

View program details
(digital TV program,
where provided in the
broadcast)

Ctrl >

Skip ahead

Ctrl <

Skip back

Ctrl S

Display subtitles

Ctrl W

Full screen toggle

Alt F

Open File menu for
playback

Alt M

Open the Task Menu

Alt P

Previous channel

Ctrl Q

Pause
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Troubleshooting
Some notes on system compatibility
Decoding high definition ATSC TV is very CPU intensive. A graphics card with at
least 64MBytes of memory and the latest graphics driver from the manufacturer
makes the decoding task easier. Typically a 2.2 GHz Pentium 4 processor or
equivalent with a graphics card having 64MBytes of memory is required to properly decode ATSC digital TV on your PC. A 1.6GHz AMD Sempro laptop computer
tested in the Hauppauge lab used 50% of the CPU for playing ATSC 640i format,
and 90% of the CPU when playing ATSC 1080i, the highest definition ATSC format.
In some cases, either a faster processor or more graphics memory might be
required. Slow or jerky video and a noisy TV picture indicate system performance
problems.

Jerky video with live ATSC or QAM digital TV
Jerky or distorted video can be caused by two things in your PC or laptop: a slow
CPU which cannot decode the ATSC TV signal fast enough, and a graphics system which cannot keep up with the high datarates of digital TV.
Many times, improving the performance of the graphics display will fix the jerky
video display of ATSC digital TV. Here are some tips on improving graphics performance:
- Use the latest graphics driver: graphics drivers are often ‘tweaked’ to improve
performance, especially the built-in graphics on laptops. Check the Microsoft
Windows update site to download the latest graphics driver for your computer. For
Dell computers, check the Dell website for the latest graphics driver.
- Use WinTV v7 Video Renderer settings to optimize graphics performance: The
Video Renderer is found in the General tab of WinTV v7, and is used to change
the display mode of a graphics card for TV watching. This setting does not affect
any other Windows program.
The default mode is EVR. The other modes are VMR9, VMR7 and Overlay. Each
mode uses a different process to render video. Try each mode and use the one
which gives you the best results.
To use hardware graphics acceleration, put a check in the tick box Use hardware acceleration when possible. This will allow your graphics system to use
hardware acceleration for video decode. Note: graphics hardware acceleration
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does not work on all systems.
If this setting does not help, or if you experience WinTV not responding after a
channel change, then your graphics system cannot use hardware graphics acceleration. In this case go back to settings and uncheck “use hardware acceleration”
and rerun WinTV.

Only some channels are found during ATSC channel scan
If you are only receiving some known TV channels when scanning, it means your
TV antenna is not adequate to pick up the channel. You will need either an antenna signal booster (a Radio Shack antenna amplifier will work) or a high gain
antenna. Here’s a link to an ATSC antenna selector:

http://www.antennaweb.org/aw/address.aspx
Black window when selecting an ATSC channel
If analog channels are displayed correctly but you see a black window when
selecting an ATSC channels, this means that WinTV is not getting a signal. This is
most often due to poor reception. See “Only some channels are found during
ATSC channel scan” above.
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Uninstalling the WinTV driver and applications
Run the hcwclear.exe from the installation CD. Select OK A black screen will
briefly appear and once it has disappeared the software will be removed. If you
now re-start the computer you will be at Step 4 of the installation.

The Hauppauge Remote Control
(optional on some models)
The WinTV remote control software is installed automatically during the installation of the WinTV applications.
You will see the WinTV Remote icon in the Device Tray. The installation will add a
shortcut to IR.EXE to the Startup group, so that IR.EXE is loaded every time after
Windows has booted.
If you need to restart the remote control, select Restart IR from the Start \ All
Program Files\WinTV directory.
Please ensure the following before trying to use this option:
1.

Infrared Remote control - has batteries inserted

2.

Infrared-Receiver, is fully connected to the IR socket of the WinTV-Card

3.

Infrared software is started - The IR icon is on the start bar

To start WinTV press the GO button and a menu will appear. Use the scroll up and
down button to select WinTV and press OK to select.

Remote control buttons
Go button: launches WinTV.
Power button (green): close WinTV or launches Windows Media Center.
TV button: when WinTV is running, hitting the TV button causes WinTV v7 to go
to “live mode” and turns off recording or pause.
Red record button: starts recording using the parameters set in the Pref menu.
Pause button: if watching live TV, will pause the video. When recording, this button will pause the video but WinTV will continue to record. If playing back video,
this button will pause the video playback.
Stop button (square icon): stops live TV, the recording or playback.
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Play button: plays the
last video recorded.

Go button

Back/Exit button: will
close the current menu or
exit full screen mode.

TV
button

0 - 9 buttons: When in
“live” TV mode, is used to
directly enter channel
numbers. When playing
back a recording, the “1”
button will skip to 10%,
the “2” button 20%, etc.
of the length of the
recording.
Skip ahead button: skip
ahead 30 seconds.
Skip back button: skip
back 30 seconds.
Go button: Start WinTV.
Menu button: opens
channel list.

Back/Exit
button
Audio
mute
Volume
up/down

Menu

Record
button
Play
button

Channel
up/down

Fast
rewind

Stop
button
Fast
forward

Skip
back

Skip
ahead
Pause
button

Red button at bottom:
Full screen TV

0-9
“Quick
Skip”
buttons

Green button at bottom: not currently used
Yellow button at bottom: not currently used

Subtitle
button

Blue button at bottom:
not currently used
Sub/CC (#):
titles on / off

Application
on/off

Red
Green
Yellow
Blue
buttons

Sub-
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Configuring the WinTV-HVR-1850 and
WinTV-HVR-2250 built-in IR blaster for
use with WinTV v7
The IR Configuration Utility is used to configure the WinTV-HVR-2250 and
WinTV-HVR-1850’s built-in remote control IR blaster for use with either WinTV v7
or Windows Media Center.

ote: the remote control is initially configured for Windows Media
Center. If you want to use the IR blaster with WinTV v7, you must run
this utility.

N

To run the IR configuration utility, go to the WinTV program group and click on
HCWCIRConfig_Tool.exe (this file can also be found on the WinTV V7 installation CD
in the MISC folder).
To configure the IR blaster for use with WinTV v7, remove the check from
the box labeled Hauppauge WinTV.
To configure as a Windows Media Center remote control, put a check in the

box labeled “Hauppauge Consumer Infrared Receiver”
Click OK to save the changes.

ote: your computer must be restarted for the changes to take effect.

N

Setting up the IR Blaster for use with WinTV v7
In WinTV v7, the IR RemoteBlaster lets the WinTV-HVR board change the channel on a satellite or cable TV set top box by transmitting ‘channel change’ commands to the box via an Infra Red (IR) transmitter.
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ote: You will need the remote control from your set top box to complete the configuration in this section.

N
N

ote: this proceedure is only necessary if you are using WinTV v7. If
you are using Windows Media Center, it will configure the IR blaster
automatically
The WinTV-HVR’s IR blaster function consists of two components:
1.

IR Blaster cable. This cable has an IR cable jack and an IR transmitter. The IR
cable jack plugs into the back of the WinTV board, and the IR transmitter needs to
be positioned over the IR receiver on your set top box using the self stick tape
supplied on the front of the transmitter.

2.

IR Blaster Config program (BlastCfg.EXE) for configuring the codes for the IR
transmitter.

During the installation of the WinTV applications from the Installation CD-ROM, the
Hauppauge IR Blaster applications will be automatically installed.
Every time you boot Windows, the IR32 application should automatically run. You
will notice a small IR icon in your system device tray.

The IR Blaster Configuration program
The IR Blaster Configuration program allows you to choose the cable TV or satellite set top box to control, or to “learn” a new set top box. The IR Blaseter
Configuration program can be found in the Program Groups / Hauppauge
WinTV. Run BlasterCfg.EXE
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To set up the IR Blaster, see the guide
IRRemoteBlaster Quick
Installation Guide for WinTV v7.

Learning remote control
codes for your set top box
Send button

First make sure the WinTV IR transmitter is positioned over the remote
sensor on your set top box.
Remember, the WinTV IR transmitter has a very short transmission distance and needs to be positioned
over the remote sensor on your set
top box.

Key numbers

To access the learn function in
BlastConfig.exe, click on Advanced
Config and Learn.
You will need to ‘learn’ the 0 through
9 keys, plus Power on and Enter. To
learn the new keys:
-

hold the remote control from
your set top box as close to the

Message box

IR receiver and learn sensor
as possible

-

in the Blaster config program, click the button you would like to learn (for
example: 1)

-

then depress and hold the corresponding key on your set top box remote control. You will be instructed in the message box when to release the key onyour
remote control.

Do this for the keys 0 to 9 plus On and Enter
You should receive a LearnKey(key#) Succeeded message. Then move on to
the next key.
If you receive a LearnKey(key#) Failed error, this means that the key was either
held down too long, or not long enough, or that the remote was not held close
enough to the IR sensor on the HD PVR. Try again.
Once you are finished with the numbers 0 to 9 and On and Enter, you can test
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the learning by clicking the Send button in the Blaster Configuration program. It
will send the numbers 123 to your set top box. Your set top box should now be
on channel 123.
Close the Blaster Configuration program and your configuration will be saved.
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